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RENDU PARTAGE AVEC 
LIGHTWAVE [8] (PC ET MAC) 

 
LightWave vous permet de profiter de la puissance de calcul des autres ordinateurs connectés sur un réseau pour 

effectuer le rendu des scènes. On parle de rendu partagé. Vous devez savoir qu’une telle utilisation requiert des 
connaissances sur les réseaux d’ordinateurs qui dépassent le cadre de ce manuel. 

ScreamerNet utilise le panneau Network Rendering (Render > Utilities: Network Render) de LightWave pour 
soumettre les scènes à calculer aux processeurs du réseau sur lesquelles tourne l’application ScreamerNet. 
ScreamerNet peut contrôler jusqu’à 1 000 processeurs. (Note : un seul ordinateur peut avoir plus d’un processeur. 
Chaque processeur compte pour un.) Chacun effectue le calcul d’une image de l’animation jusqu’à ce que le rendu 
de la scène soit terminé. 

NOTE 
Vous pouvez aussi la fonction de rendu partagé de LightWave pour effectuer le rendu par lots 
de plusieurs scènes sur un même ordinateur. 

SCREAMERNET II 

ATTENTION 
Les noms des fichiers scène, objet et image ne doivent pas contenir d’espace, ni de caractères 
accentués. Utilisez plutôt le trait de souligné (_) à la place des espaces (par exemple, 
MA_VOITURE.LWO au lieu de MA VOITURE.LWO). Cela est essentiel pour assurer un 
fonctionnement correct de ScreamerNet. Si les noms contiennent des espaces ou des 
caractères accentués, ScreamerNet et LightWave risquent de considérer que ces fichiers sont 
endommagés. 

Avec le mode ScreamerNet II, il n’est plus nécessaire de charger la scène sur la machine de contrôle. Du 
moment que les fichiers scène, objet et image nécessaires (ainsi que les dossiers de stockage des images rendues) 
sont accessibles par tous les processeurs du réseau, chaque machine peut charger la scène et enregistrer les images 
directement sur le ou les disques partagés. De plus, ScreamerNet II vous permet d’effectuer un rendu par lots 
pouvant traiter jusqu’à 100 fichiers scène différents. 

L’utilisation de ScreamerNet II consiste à lancer le module de rendu (LWSN) sur tous les ordinateurs impliqués 
dans cette opération, cela pouvant aussi comprendre l’ordinateur de contrôle. Puis, vous lancez LightWave sur 
l’ordinateur de contrôle et vous indiquez la ou les scènes à calculer. 

Comme la communication établie par ScreamerNet entre les ordinateurs est basée sur l’écriture de fichiers, les 
protocoles NetBEUI et TCP/IP ne sont pas nécessaires. Il suffit que chaque ordinateur puisse accéder aux 
fichiers/dossiers des autres ordinateurs et écrire des fichiers sur le réseau pour que ScreamerNet fonctionne 
correctement. 

CONSEIL 
Notez qu’il n’est pas recommandé d'utiliser des nœuds de rendu d'architecture différente (c’est-
à-dire Intel, Macintosh, etc.). En effet, le rendu sur chaque type de processeur risque de donner 
des résultats qui ne sont pas cohérents, ce qui se traduira par des défauts d'affichage dans 
l'animation finale. 
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Utilisation de ScreamerNet II 
L’hôte est l’ordinateur sur lequel LightWave est installé. Les nœuds sont les autres ordinateurs du réseau utilisés 

pour le rendu. Ni LightWave, ni la clé de protection de LightWave n’ont besoin d’être installés sur les ordinateurs 
nœuds. 

Le point essentiel pour le bon fonctionnement de ScreamerNet est le partage des disques. Il existe différentes 
façons de configurer un réseau et, donc, de mettre en place ScreamerNet. 

NOTE 
ScreamerNet ne peut pas calculer de fichiers animation. Il ne sait effectuer que le rendu de 
séquences d'images. 

Phase préparatoire sur PC 
1 Sur l’hôte, partagez le(s) lecteur(s) contenant les dossiers de Windows, de LightWave et le Content 

Directory de LightWave. Dans la suite, on suppose qu’il s’agit d’un même lecteur. 
2  Sur chaque nœud ainsi que sur l’hôte, connectez-vous au lecteur partagé sous la lettre L:. 
3  Sur l’hôte, éditez le fichier de configuration LWEXT8.CFG avec un éditeur de textes (comme NOTEPAD ou le 

Bloc-notes de Windows) 
  Sous Windows 2000 et XP, l’emplacement de ce fichier est, par défaut : 
   DOCUMENTS AND SETTINGS\[UTILISATEUR] 
 où [UTILISATEUR] est le nom que vous entrez pour démarrer une session Windows. 
4  Dans tous les chemins d’accès aux fichiers plug-ins .P et lscripts .LSC et .LS figurant dans ce fichier, 

remplacez la lettre du lecteur local (comme C:) par la lettre du lecteur partagé L: (par exemple, 
L:\\LIGHTWAVE\\PLUGINS\\INPUT-OUTPUT\\TIFF.P). Faites attention à ne pas supprimer ou modifier les 
doubles backslash (\\) présents dans ces chemins d’accès. 

5  Enregistrez le fichier. 

Phase préparatoire sur Macintosh 
1 Sur l’hôte, partagez le(s) lecteur(s) contenant les dossiers Dossier Système, LightWave et Content Directory 

de LightWave. Dans la suite, on suppose qu’il s’agit d’un même disque nommé HD. 
2 Sur chaque nœud, connectez-vous au disque partagé de l’hôte. 
3 Créez un dossier SCREAMERNET sur le disque dur de chaque nœud. 
4 Dans chacun des dossiers SCREAMERNET, copiez les fichiers LWSN et LWSN CMDLINE ainsi que tous les 

fichiers .HSLB et .ENU situés dans le dossier PROGRAMS de LightWave sur le disque partagé de l’hôte. 

NOTE 
Que ce soit sur PC ou Macintosh, l’ordinateur hôte peut aussi devenir un nœud de rendu. Pour 
cela, il est préférable d’utiliser les techniques de partage décrites ci-dessus mais vous pouvez, 
si vous le désirez, vous servir de chemin d’accès locaux sur l’hôte. 

Configuration de l’hôte 
1 Sur l’hôte, créez un nouveau dossier nommé COMMAND dans le dossier PROGRAMS de LightWave. 
2 Lancez LightWave. Ouvrez le panneau Network Rendering (Render > Utilities: Network Render) et 

cliquez sur le bouton Command Directory. Choisissez le dossier COMMAND que vous venez de créer. Vous 
verrez apparaître un message vous demandant si vous voulez effectuer une réinitialisation. Cliquez sur No. 

3 Réglez la valeur de Maximum CPU Number sur le nombre de nœuds/processeurs présents sur votre réseau. 
4 Sous l’onglet General Options du panneau Preferences, vérifiez que Content Directory fait bien référence 

au dossier approprié. 
5 Quittez LightWave afin d’enregistrer ces modifications dans son fichier de configuration. 
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Mise en place des nœuds de rendu sur PC 
1 Sur le premier nœud, créez un raccourci vers le programme LWSN.EXE situé sur le lecteur partagé L: 
 Dans la ligne de commande, tapez un espace après LWSN.EXE puis : 

 -2 "-cL:\DOCUMENTS AND SETTINGS\[UTILISATEUR]" 
L:\LIGHTWAVE\PROGRAMS\COMMAND\JOB1 
L:\LIGHTWAVE\PROGRAMS\COMMAND\ACK1 

où [UTILISATEUR] est le nom que vous entrez pour démarrer une session Windows. 
Notez que la commande doit être entrée sur une seule ligne. (Ci-dessus, elle n’a été inscrite sur plusieurs 
lignes que pour la clarifier. En réalité, vous devez appuyer sur la touche ESPACE à chaque changement de 
ligne afin de séparer chaque argument de la commande.) 
Ce qui précède suppose que les fichiers de configuration de LightWave sont situés à leur emplacement par 
défaut et que le dossier Command Directory désigne le dossier L:\LIGHTWAVE\PROGRAMS\COMMAND. Si ce 
n’est pas le cas, modifiez la ligne de commande en conséquence. 
De plus, si un des chemins d’accès contient des espaces, vous devez placer l’argument correspondant entre 
guillemets (comme "-cL:\DOCUMENTS AND SETTINGS\[UTILISATEUR]"). 

2 Donnez un nom approprié au raccourci. 

Mise en place des nœuds de rendu sur Macintosh 
1 Sur le premier nœud, ouvrez le fichier LWSN CMDLINE avec TextEdit. (Note : si ce fichier n’existe pas, 

créez simplement un nouveau fichier texte vide TextEdit.) 
 Tapez le texte suivant dans ce fichier : 
  -2 -cHD:USERS:[UTILISATEUR]:LIBRARY:PREFERENCES 

 HD:LIGHTWAVE:PROGRAMS:COMMAND:JOB1 
 HD:LIGHTWAVE:PROGRAMS:COMMAND:ACK1 
Notez que la commande doit être entrée sur une seule ligne. (Ci-dessus, elle n’a été inscrite sur plusieurs 
lignes que pour la clarifier. En réalité, vous devez appuyer sur la touche ESPACE à chaque changement de 
ligne afin de séparer chaque argument de la commande.) 
Dans ce qui précède, on suppose que les fichiers de configuration de LightWave sont situés dans 
HD:USERS:[UTILISATEUR]:LIBRARY:PREFERENCES, [UTILISATEUR] étant le nom que vous entrez pour 
démarrer une session MacOS X. On suppose aussi que le dossier Command Directory de LightWave désigne 
le dossier HD:LIGHTWAVE:PROGRAMS: COMMAND. Si ce n’est pas le cas, modifiez la ligne de commande en 
conséquence. 
De plus, si un des chemins d’accès contient des espaces, vous devez placer l’argument correspondant entre 
guillemets (comme "-cHD:DOSSIER SYSTEME:PREFERENCES"). 

2 Enregistrez le fichier LWSN CMDLINE. 

ATTENTION 
Si vous utilisez TextEdit (MacOS X) pour éditer ou créer ce fichier, vous devez, avant de 
l’enregistrer, le convertir au format texte en choisissant Format > Convertir au format Texte si 
le fichier actuel est au format RTF. 

Notes à propos de la ligne de commande de LWSN 
Le paramètre -c permet d’indiquer le chemin d’accès du dossier contenant les fichiers de configuration. 
Dans les commandes pour les autres nœuds de rendu, vous devez augmenter les numéros de Job et Ack d’une 

unité à chaque fois. Par exemple, le nœud numéro 2 utilisera JOB2 et ACK2, le nœud numéro 3 utilisera JOB3 et 
ACK3, et ainsi de suite. Le numéro Job/Ack est égal au numéro CPU utilisé par ScreamerNet pour identifier le nœud 
et est compris entre 1 et la valeur de Maximum CPU Number dans le panneau Network Rendering (voir plus loin). 
(Vous devez, à chaque fois, spécifier le chemin d’accès complet aux fichiers JOB et ACK.) 
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Mise en route des nœuds de rendu 
Sur chaque nœud de rendu, lancez LWSN en double-cliquant sur son icône (ou sur l’icône de son raccourci.). 

 

 

Fenêtre de sortie de LWSN sous Windows 

NOTE 
Après le lancement de LWSN, un message du type Can’t open L:\Lightwave\Programs\ 
Command\Job1 peut apparaître. C’est normal tant que LightWave n’a pas initialisé 
ScreamerNet. 

Contrôle du rendu en réseau 
1 Sur l’hôte, ouvrez le panneau Network Rendering (Render > Utilities: Network Render) et cliquez sur le 

bouton Screamer Init. Tous les processeurs sur lesquels tourne ScreamerNet doivent apparaître dans la 
fenêtre. (Le numéro Job/Ack attribué à chaque ordinateur nœud correspond au numéro CPU dans la fenêtre 
Network Rendering.) 

 
Panneau Network Rendering 

2 Cliquez sur Add Scene To List et ajoutez une ou plusieurs scènes. 

 
Ajout de scène pour le rendu 
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3 Cliquez sur Screamer Render pour lancer le rendu des scènes. 

 
ScreamerNet est en train d’effectuer le rendu de la scène 

Fermeture des nœuds 
Lorsque tous les processeurs ont fini le rendu, cliquez sur le bouton Screamer Shutdown pour fermer la fenêtre 

ScreamerNet sur tous les nœuds et arrêtez le programme. Pour commencer une nouvelle session, vous devez 
relancer ScreamerNet sur chaque processeur et effectuer une réinitialisation des processeurs depuis l’hôte. 

Abandon d’une session de rendu 
Appuyez sur la touche ECHAP pour arrêter la session ScreamerNet en cours. Il peut se passer un temps assez 

long avant que tous les nœuds soient de nouveau prêts car chacun doit terminer la tâche en cours, en particulier dans 
le cas d’une scène complexe. (Note : le rendu par ScreamerNet ne peut être interrompu que lorsque la phrase 
Waiting for CPUs to finish rendering figure dans le panneau Network Rendering). 

ATTENTION 
Si vous fermez la fenêtre ScreamerNet sur un des nœuds de rendu, vous risquez d’avoir à 
redémarrer tous les nœuds et à les réinitialiser. 

Modification du nombre de nœuds 
En modifiant la valeur figurant dans la case Maximum CPU Number (8, par défaut), vous indiquez à l’hôte 

combien de nœuds il doit rechercher. Vous pouvez entrer une valeur allant jusqu’à 1000 mais nous vous conseillons 
d’indiquer le nombre de nœuds réellement disponibles afin d’éviter de perdre du temps lors de la recherche. Cette 
valeur est stockée dans le fichier de configuration lorsque vous quittez LightWave. 

Syntaxe de ScreamerNet II 
La syntaxe de la ligne de commande pour LWSN.EXE -2 est : 
LWSN -2 [-c<DOSSIER CONFIG>] [-d<CONTENT DIRECTORY>] [-q] [-t<INTERVALLE>] 

<FICHIER JOB> <FICHIER ACK> 

 Le paramètre -D indique quel est le dossier Content Directory à utiliser. (Si ce paramètre n’est pas spécifié, le 
dossier Content Directory défini dans la scène est utilisé.) 

L’intervalle de vérification est défini en secondes. Il indique combien de temps va s’écouler entre chaque 
vérification de commandes pendant le rendu. Si le paramètre -T n’est pas utilisé, le rendu est ininterrompu et LWSN 
ne vérifie pas le fichier job tant que son travail de rendu actuel n’est pas terminé. Avec l’argument -T, il vérifiera à 
des intervalles de temps donnés la présence de deux commandes : status et abort. (Toutes les autres commandes sont 
ignorées.) (Note : le véritable intervalle de vérification peut être plus long que celui spécifié en fonction de 
l’opération en cours.) 
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Informations d’enregistrement de la scène 
• Lors de la mise en place de la scène, vous devez utiliser correctement le dossier Content Directory. Sinon, des 

nœuds risquent d’être incapables d’effectuer le rendu de la scène. 
• Définissez toutes les options de rendu (comme l’enregistrement des fichiers) avant d’enregistrer la scène. Vous 

voudrez, certainement, enregistrer les images rendues dans un dossier commun partagé sur le réseau et 
accessible depuis tous les ordinateurs. Vous pouvez aussi les enregistrer localement sur chaque nœud mais 
n’oubliez pas que chacun d’eux obtiendra le chemin d’accès pour l’enregistrement des fichiers à partir d’un 
même fichier scène. 

Rendu par lot sur un ordinateur 
Un réseau n’est pas obligatoire pour pouvoir utiliser ScreamerNet. Suivez simplement les instructions données 

pour l’installation sur un réseau comme si vous n’aviez qu’un hôte et un nœud. C’est même un peu plus simple car 
vous n’avez pas à vous préoccuper de dossiers partagés et de noms de volumes. Cela permet d’effectuer 
automatiquement le rendu d’un ensemble de scènes. C’est encore plus intéressant si vous utilisez une machine bi-
processeur : chaque processeur peut être traité comme un nœud de rendu distinct. 

GUIDE DES PANNES 
Si, lorsque vous cliquez sur Screamer Init, aucun processeur n’est détecté, reprenez à partir de la partie 

Configuration de l’hôte. 
Si le rendu semble aller beaucoup trop vite et qu’aucune image n’est enregistrée : 

1 Assurez-vous que vous avez bien un accès complet (en lecture et en écriture) sur le réseau. Vous pouvez vérifier 
cela en essayant de copier un fichier sur les différents lecteurs du réseau. 

2 Si vous avez créé des scènes et des objets sans tenir compte de la nouvelle dénomination du lecteur, le rendu ne 
pourra s’effectuer correctement que sur l’hôte. 
Les erreurs les plus fréquentes avec ScreamerNet se produisent lorsque trop d’ordinateurs essaient de lire ou 

d’écrire en même temps des informations sur l’ordinateur hôte pendant que celui-ci effectue un rendu. 
• N’utilisez pas le rendu ScreamerNet sur l’hôte mais servez-vous en plutôt comme un serveur sur lequel se 

trouvent les disques durs auxquels accèdent les nœuds. 
• Connectez-vous à un disque d’un autre ordinateur sous le nom de Y:, par exemple, et configurez vos scènes de 

telle façon que les images rendues soient enregistrées sur ce disque. Les nœuds ne peuvent pas savoir que ce 
disque n’est pas physiquement présents sur l’hôte. 
Un autre problème courant apparaît lorsque l’espace sur le disque où sont enregistrées les images devient 

insuffisant. Cela provoque, à la fois, une erreur dans LightWave et dans les nœuds de rendu ScreamerNet.  

RENDU SANS LIGHTWAVE 
Le programme LWSN dispose aussi d’un mode qui vous permet d’effectuer le rendu d’une scène sans lancer 

LightWave. Il n’y a alors pas d’hôte et, donc, pas de rendu partagé par réseau. Vous devez indiquer au programme 
précisément ce qu’il doit calculer. La syntaxe de la commande est la suivante : 

LWSN -3 [-c<DOSSIER CONFIG>] [-d<DOSSIER BASE>] <FICHIER SCENE> <PREMIERE IMAGE> 
<DERNIERE IMAGE> [<PAS EN IMAGES>] 

Comme vous pouvez le noter, vous indiquez simplement les informations de base nécessaires au rendu de la 
scène. Voici un exemple sur PC : 

LWSN -3 -cD:\LIGHTWAVE -dM:\NEWTEK SPICEGIRLS.LWS 1 900 1 

Cette commande effectue le rendu des images 1 à 900 de la scène Spicegirls en utilisant les fichiers de 
configuration situés dans le dossier D:\LIGHTWAVE et M:\NEWTEK comme dossier Content Directory. 

L’argument -c est optionnel si les fichiers de configuration se trouvent à leur emplacement par défaut (voir les 
appendices). De même, si le dossier Content Directory est correctement spécifié dans le fichier de configuration, 
l’argument -d n’est pas nécessaire. 

CONSEIL 
Vous pouvez connaître la syntaxe pour ScreamerNet en tapant simplement LWSN sans aucun 
argument dans une fenêtre Invite de commandes. 
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